
Chapter 3

Keyboard Shortcuts

When Excel gurus hear that Microsoft changed the menu system, they are often most concerned 
about all of the shortcut keys that they previously learned.

In Excel 97 – Excel 2003, most menu items had a single letter underlined. If you wanted to selected 
Edit – Fill – Justify from the menu, you simply had to hold down the Alt key while typing the 
underlined letter from each menu selection. Thus, Alt+E+I+J would allow you to quickly select the 
Justify command.

There are a few menu commands that I have memorized and I can type those shortcuts in my 
sleep.

In 80% of the cases, Excel 2007 will support your knowledge of legacy shortcut keys. 

All Ctrl Key Shortcuts Continue to Work
Any Ctrl key shortcuts will continue to work. Some of the popular Ctrl shortcuts:

Ctrl+B for Bold 

Ctrl+I for Italics

Ctrl+U for Underline 

Ctrl+A to select All

Ctrl+C to Copy  

Ctrl+X to Cut

Ctrl+V to Paste 

Ctrl+Z to Undo

•

•

•

•

•

•

•

•

Most Alt Shortcuts for Edit, View, Insert, Format, Tools, and Data Will Work

When you press Alt+E, Alt+V, Alt+I, Alt+O, Alt+T, or Alt+D, Excel 2007 enters a special Offi ce 
2003 compatibility mode. A box appears in the top center of the screen showing the Offi ce 2003 
access keys that you have entered so far. When you enter enough keys to invoke a menu command 
in Excel 2003, the command will be invoked in Excel 2007.
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In Figure 3.1, two-thirds of the keystrokes for Edit-Fill-Justify have been selected. When you 
strike the J, Excel will invoke the Justify command.

Figure 3.1
When you use the old Alt key 
sequences, this tip shows 
the keys you have pressed 
so far. It would have been 
helpful if they would have 
shown Edit – Fill.

Caution! While this feature is good in theory, it does not work fast enough in the beta. There is 
a slight delay when you press Alt+E. I fi nd that I usually have typed the I+J before the Offi ce 
2003 access key window appears. So, to use the Alt keyboard shortcuts that you’ve memorized 
from Offi ce 97-2003, you have to type them a bit slower than normal.

Using the Offi ce 2007 Keyboard Shortcuts

If you are a fan of using the keyboard, you might have noticed one problem in Excel 2003. There 
were often menu items that did not have a keyboard shortcut. In Excel 2007, every menu item can 
be selected from the keyboard.

To access the new keyboard shortcuts, press and release the Alt key on the keyboard.

Excel displays a single-character keyboard shortcut for each tab of the ribbon.

If any contextual ribbon tabs are visible, they will have a two-character shortcut key.

All of the icons on the QAT are assigned a numeric keyboard shortcut. The fi rst nine items are 
assigned the keys 1 through 9. Icons after that are assigned a two-character shortcut starting with 
a zero.

Figure 3.2
Press and release 
Alt to see the new 
shortcut keys.

Tip: Alt+F (File), Alt+W (Window), and Alt+H (Help) behave differently. 
Read about these keys below.
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When you press F, H, N, P, M, A, R, or W, Excel displays the appropriate tab of the ribbon. The 
original shortcut key tips are replaced with new keytips that allow you to select any of the items 
in the ribbon. Figure 3.3 shows the key tips for the Data ribbon.

Figure 3.3
Press a shortcut key for the 
Data ribbon and you will see the 
Data shortcut keys.

Some of the key tips make sense: A for Sort Ascending; D for Sort Descending; W for What If; V for 
Validation. Other shortcuts just seem to use the left over letters.
If you type W to select What If Analysis, its dropdown provides you with three new shortcut keys 
from which to select items.

Figure 3.4
As you type additional 
shortcut keys, new shortcut 
keys appear until you fi nally 
actually select a command.

While the keyboard shortcuts for the QAT will constantly change, depending on how your QAT is 
customized, you should fi nd that the keyboard shortcuts for the ribbon will remain constant. You 
can memorize that Alt+A+A will sort in ascending order. Alt+A+W+G will open the Goal Seek 
dialog.
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Accessing the Old File and Window Menus

In Excel 2003, Alt+F would open the File menu. Alt+W opened the Window menu. In Excel 2007, 
these keystroke combinations do not show the Offi ce 2003 keyboard shortcut window. Instead, 
Alt+F opens the Offi ce Icon menu and Alt+W opens the View ribbon.

Many of the keyboard shortcuts in the Offi ce Icon menu match the same shortcuts as in the File 
menu.

Figure 3.5
Alt+F opens the 
Offi ce Icon menu.

Thus, Alt+F+S was File – Save in Excel 2003, and this combination still 
executes a Save in Excel 2007. 

Alt+F+D+A in Excel 2003 was File – Send to – Mail Recipient as Attachment. 
In Excel 2007, Alt+F+D still gets you to the Send menu, but now E is used 
to send a fi le as an e-mail attachment and A is used to send a fi le as an XPS 
attachment (Microsoft’s new open source fi le format meant to compete with 
Adobe PDF). 

Figure 3.6
Some of the old keystrokes don’t 
quite work. If you had memorized 
Alt+F+D+A, it is now Alt+F+D+E.

Pressing Alt+W in Excel 2003 opened the Window menu. The commands on the old Window menu 
were New Window, Arrange, Compare Side by Side, Hide, Unhide, Split, and Freeze Panes.

Pressing Alt+W in Excel 2007 opens the View ribbon. All of the keyboard shortcuts (N, A, B, H, U, 
S, and F) perform identical actions in Excel 2007.
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Figure 3.7
All of the Alt+W 
shortcuts from Excel 
2003 still work.

Note: In Excel 2003, Alt+W+2 would switch to the next open workbook. To do 
this in Excel 2007, use Ctrl+Tab.

Accessing Commands on the Excel 2003 Help Menu

Microsoft has simply abandoned the Alt+H command to access commands on the Excel 2003 Help 
menu.
 
The Offi ce 2007 paradigm is that Alt+H takes you to the Home menu.

This is not a horrible loss, since there were not many commands on the Excel 2003 Help menu that 
you would have accessed using Alt+H. Alt+H+H would open Help, but the F1 key did, too, and 
continues to be a faster way to access Help.

Bonus Tip: Using the Keyboard to Enter Formulas

This trick is not new, but it is a faster way to enter formulas. In fact, the trick originated with 
Lotus 1-2-3 back in the 1980s. If you are a fan of using the keyboard, you should learn this method 
for entering formulas.

Say that you need to enter a formula in B8 a shown in Figure 3.8.

Figure 3.8
The fastest way to enter 
this formula is the arrow 
key method.

Start in cell B8. Type either an equals sign or a plus sign. If you regularly use the numeric 
keypad, it is easier to type a plus sign.

Press the up arrow three times. Excel shows a fl ashing cursor around cell B5. The provisional 
formula in B8 shows =B5.

1.

2.
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* * *

Figure 3.10
When you type a math 
sign, the focus returns 
to the original cell. It 
required two up arrow 
presses to arrive at B6.

Type a plus sign.

Type the up arrow to move to B7.

Type the Enter key to accept the formula.

4.

5.

6.

Figure 3.11
The fi nal formula

If you try it, you will fi nd that typing =���-��+�<Enter> is far faster than using the mouse to 
enter the formula.

Type a minus sign to continue the formula. The fl ashing box disappears. The focus returns to 
cell B8. If you want to point to cell B6, type the up arrow two times. The provisional formula 
now shows =B5-B6.

3.

Figure 3.9
B8 is still the active 
cell (thick border), but 
you are pointing to B5 
(dashed border).



Chapter 4

Taming the QAT & 
Finding the Mini Bar

Although you now understand why Microsoft eliminated the menu and toolbars in favor of a 
ribbon, there is still one fundamental problem. In a toolbar system, there were certain icons that 
were always available at the top of your screen.

In Excel 97-2003, you always had quick access to icons for bold, italics, cut, paste, align right, 
decrease decimal, sort ascending, print preview, the chart wizard, and more.

With Excel 2007, these icons are spread across seven ribbon tabs, so the odds are that you will 
not always have access to the various icons that you might need. Microsoft addresses this problem 
with the Mini Toolbar and the QAT (Quick Access Toolbar).

The Mini Toolbar is a fl oating toolbar that fades into view whenever you select text in Excel. 
This toolbar offers 17 formatting icons. Surprisingly, however, it is fairly rare in Excel to select 
text. Selecting an entire cell does not count – you actually have to select characters within the 
cell.

 The Quick Access Toolbar (QAT) is a toolbar that is always visible near the ribbon. While the 
QAT initially contains four icons (Save, Print Preview, Undo, and Redo), you can customize 
the QAT to hold all of your favorite icons. One set of customizations can apply to all workbooks 
opened on the computer, while a second set of icons can be defi ned to open for each specifi c 
workbook.

Finding the Mini Toolbar

If you have used Outlook 2003, you might be familiar with toolbars that fade in. When you receive 
a new Outlook message, a notifi er box starts to appear in the lower right corner of the screen. This 
notifi er shows the subject line, the fi rst words in the message, and icons to immediately delete or 
open the e-mail. If you are busy working on a document and ignore the notifi er, it slowly fades 
away. However, if you move the mouse towards the notifi er, it solidifi es so that you have time to 
hit the Delete button in order to eliminate the mail if it is junk.

The Mini Toolbar uses similar technology. I think it will appear much more frequently in Word 
and PowerPoint than it will appear in Excel. It is possible to use Excel 40 hours a week and never 
see the Mini Toolbar appear.

•

•

Note: During the beta period, Microsoft has variously called this feature a “Mini Bar”, “Mini 
Toolbar” and a “Floaty”. While I prefer visiting the “Mini Bar”, it looks like “Mini Toolbar” will 
win out in the fi nal version. When I write books for QUE, the editorial guidelines there state 
that the “T” in toolbar is never capitalized. While I generally agree with this, to me, “Mini 
Toolbar” is just a bad replacement for “Mini Bar”, and so I will capitalize the T. After all, you 
wouldn’t drive a “Mini cooper” automobile, would you?
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In Figure 4.1, the Mini Toolbar is just starting to appear after double clicking a chart title to select 
the characters in the title. The toolbar is so light that it is diffi cult to guess if it will even show up 
as this book goes through the printing press. The Mini Toolbar starts just above the “r” in Chart.

If you then hold the mouse still, the Mini Toolbar will remain in its nearly invisible state. If you 
move the mouse left or down, the Mini Toolbar will become completely invisible.

However, if you move the mouse right or up by a few pixels, the Mini Toolbar fades completely into 
view.

The theory behind the Mini Toolbar is that a leading reason for selecting text is that you might be 
planning on formatting the text. The Mini Toolbar puts sixteen popular formatting commands at 
your mousetip. You can do a fair amount of formatting without ever having to visit the ribbon or 
the QAT. In Figure 4.3, the font face, font size, fi ll color, line color, italics, and font color have all 
been changed using the QAT.

Figure 4.3
While I am not suggesting this is a good 
looking title, all of the changes from 
Figure 4.2 to Figure 4.3 were initiated 
using the Mini Toolbar.

Figure 4.1
Select some text and a nearly 
invisible Mini Toolbar starts to 
appear.

Figure 4.2
Move towards the Mini Toolbar and 
it solidifi es.

The Mini Toolbar is elusive in Excel for two reasons. First, it is relatively hard to select characters 
within a cell in Excel. It is easier in Excel charts or SmartArt graphics to select characters, but it 
is relatively rare to select just a few characters inside of a cell. Second, on many computers, the 
Mini Toolbar initially appears in a completely invisible state! If you don’t move the mouse pointer 
towards the completely invisible Mini Toolbar, it will never appear.
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Although the Mini Toolbar only contains 16 icons, a few of those icons lead to dropdown menus 
with signifi cant variations. In Figure 4.3, the gradient was added using the options under the 
paint bucket icon, as shown in Figure 4.4.

Figure 4.4
Some icons on the Mini Toolbar 
lead to menus with hundreds of 
options.

Mini Toolbar Tips and Notes

There are a couple of tips and notes for using the Mini Toolbar. The next sections discuss these tips.

Versions of the Mini Toolbar

The fi gures shown previously in this chapter represent the Mini Toolbar when you are formatting 
a chart title. If you cause the Mini Toolbar to appear when you are editing text within a cell, there 
are some buttons that do not apply.

Quadruple-click any non-blank cell and move the mousepointer up and to the right. An abbreviated 
version of the Mini Toolbar with seven icons will appear. It doesn’t make sense to change the 
indentation of just a few characters in a cell, so Excel produces this version of the Mini Toolbar, 
shown in Figure 4.5.

Figure 4.5
If you select characters within 
a cell, an abbreviated Mini 
Toolbar appears.
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Right-Click Any Cell to Access the Mini Toolbar

If you right-click any cell, the full Mini Toolbar appears above the cell. This is by far an easier way 
to invoke the toolbar than by selecting characters within the cell.

Customizing the Mini Toolbar

In Excel 2007, you cannot customize the Mini Toolbar. While it would be cool if Microsoft would let 
you add buttons to the toolbar, they have not enabled that functionality for this release.

I can predict that the Mini Toolbar found in this book and the Mini Toolbar in your version of Excel 
will be slightly different. Since the fi rst beta came out, customers have been lobbying Microsoft 
to add other buttons to the Mini Toolbar. Buttons have come and gone in each release of the beta. 
Some last minute lobbying will undoubtedly cause a button to be added after this book goes to 
press.

I think that the fervor with which people are discussing the Mini Toolbar suggests that it would be 
great if Microsoft would let you customize the Mini Toolbar. Maybe this will be available in Excel 
14.

When Does the Mini Toolbar Completely Disappear?

As discussed previously, if you move towards the Mini Toolbar, it solidifi es. If you move away from 
the Mini Toolbar, it disappears. You can move your mouse from southwest to northeast and cause 
the Mini Toolbar to fade into and out of view.

However, once your mouse strays a certain distance from the selection, the Mini Toolbar disappears 
and will not reappear until you reselect the text.

This distance is based on pixels. In general, though, if you move approximately 10 rows away from 
the selection in a spreadsheet with the default font and zoom, you will have hit the limit and the 
Mini Toolbar will permanently disappear.

I can see many situations where you would move away from the selection (for example, to respond 
to an incoming e-mail notifi cation). Once you’ve moved too far away from the selection, you will 
either have to re-select the text or use the formatting icons in the Home ribbon.

Permanently Disabling the Mini Toolbar

The Mini Toolbar is fairly elusive in Excel and will rarely get in your way. However, if you would 
like to permanently disable the feature, you can do so.
From the Offi ce Icon menu, choose Excel options. The very fi rst setting in the Popular category 
is Show Mini Toolbar On Selection. Uncheck the box shown in Figure 4.6 to disable the Mini 
Toolbar.

Figure 4.6
Use this setting to permanently 
disable the Mini Toolbar.
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Using the QAT

The QAT is always visible in Excel. Even if you minimize the ribbon, the QAT will remain visible. 
This makes the QAT a great place to store icons that you use frequently. With clever customization 
of the QAT, you can minimize the need to access anything on the various ribbon tabs.

The QAT can either appear above or below the ribbon. While the QAT appears a little more stylistic 
above the ribbon, it is more functional below the ribbon. When the QAT is below the ribbon, it 
requires less movement of the mouse to reach the QAT. Also, when it is below the ribbon, you have 
more space to add buttons to the QAT before the QAT starts squeezing the area used for the fi le 
name of the currently active workbook.

To change the location of the QAT, right-click on the QAT and choose Show Quick Access Toolbar 
Below the Ribbon, as shown in Figure 4.7.

Figure 4.7
Right-click the QAT to 
change the location.

When shown below the ribbon, the QAT appears just above the Formula bar in Excel.

Figure 4.8
Moving the QAT below the 
ribbon gives you quicker 
access to the QAT.



Taming the QAT & Finding the Mini Bar30

Figure 4.10
Excel remembers the order in which you 
add icons to the QAT and shows the icons 
in that sequence.

Customizing the QAT

Initially, the QAT is a tiny toolbar with three icons. It appears to the right of the Offi ce Icon, above 
the ribbon tabs, as shown in Figure 4.9.

There are fi ve ways of customizing the QAT:

Using the dropdown at the right side of the QAT to add any of 11 popular icons.

Right-clicking any icon on any ribbon and choosing to add to the QAT.

Right-clicking any icon in the QAT and choosing Remove from Quick Access Toolbar.

Right-clicking the QAT to access the Customize pane of the Excel Options dialog.

Using the Excel Options button in the Offi ce Icon menu to customize the QAT.

Quickly Customizing Using the Dropdown at the Right Side of the QAT

At the far right end of the QAT, a dropdown offers a list of 11 popular icons that you can easily add 
to the QAT. As shown in Figure 4.10, select any icons from this list to add them to the QAT.

•
•
•
•
•

Figure 4.9
Initially, the QAT is at 
the top of the window 
with three icons.
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Right-Clicking Any Icon to Add to the QAT

When you fi nd a useful icon in any ribbon, you can right-click the icon and choose Add to Quick 
Access Toolbar.

Figure 4.11
Right-click to add an 
icon to the end of the  
QAT.

Note: You can even do this with icons that are in the context ribbons, such as the 
Chart Tools ribbons. Of course, if you do this, the icons will be grayed out any 
time that a chart is not active.

There is a minor limitation on what can be added to the QAT. While you can add the Font Size 
dropdown to the QAT, you cannot add an individual selection from the Font Size dropdown to the 
QAT. If you were to right-click on the 36 point font size, Excel would offer to allow you to add the 
gallery to the Quick Access Toolbar. When you add a gallery, Excel adds a single icon to the QAT 
with a dropdown arrow. Open the dropdown arrow and you will see the complete set of options 
available in the gallery. Figure 4.12 through Figure 4.15 show gallery dropdowns for font size, font 
face, quick chart styles, and chart gridlines.

Figure 4.13
The font face gallery 
shows all of the installed 
fonts in their own font.

Figure 4.12
The font size gallery 
dropdown offers a simple 
list of font sizes.
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Figure 4.14
The charting quick 
styles icon opens to dis-
play 48 possible chart 
formats.

Figure 4.15
This gallery is the result of 
adding the large gridlines 
icon from the Chart Tools 
Layout ribbon. The two 
icons to the right in the 
QAT are the individual 
menus for Horizontal 
Gridlines and then 
Vertical Gridlines.

Right-Clicking Any Existing QAT Icon to Remove from the QAT

If your QAT is becoming crowded, you can remove individual icons by right-clicking them and 
choose Remove From Quick Access Toolbar.

Figure 4.16
Right-click an icon on 
the QAT to remove it 
from the QAT.
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Using Excel Options to Customize the QAT

All of the previous methods show quick ways to make small customizations to the QAT. If you need 
to make many customizations to the QAT, you will want to use the full-featured customization tool 
available in Excel options.

You can reach this tool using one of three methods:

Choose the Offi ce Icon – Excel Options and then click on the Customize category along the left side.

Right-click the QAT and choose Customize Quick Access Toolbar….

Open the dropdown at the right side of the QAT and choose More Commands….

The Customize dialog box has many powerful features. Here are tips for getting the most out of 
the dialog.

•
•
•

Figure 4.17
Using the QAT 
Customize tool

Select any icon in the right list box and then use the up and down buttons on the right edge of 
the dialog to re-sequence the location of the icon.

Select any icon in the left list box and then click the Add>> button to add this icon after the 
selected icon in the right list box.

The left listbox offers dozens of popular icons, but there are 31 different versions of the left 
listbox. Use the top left dropdown to choose a different version of the left listbox (see Figure 
4.18).

•

•

•

Figure 4.18
Each of these items offers 
dozens of icons that can 
be added to the QAT.
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Choose Commands Not in the Ribbon from the left listbox to locate your favorite commands 
that were not popular enough to make it to the ribbon. You will fi nd over 200 icons in this list. 
As you might guess, adding these to the QAT is the only way to access most of these commands. 
A selection of these icons is shown in Figure 4.19.

•

Figure 4.19
A few of the 200+ icons available 
in the “Commands Not in the 
Ribbon” category.

Choose Macros from the left listbox to add a custom VBA macro to the QAT. These icons are 
the only ones where you can use the Modify button. See “Adding Icons for VBA Macros to the 
QAT” below.

The left listbox always starts with a <Separator> entry. This is not an actual command, but 
draws a vertical bar in the QAT to break your commands into groups.

If you want to add commands to the QAT for the current workbook only, change the top right 
dropdown to display one of the currently open workbooks. This will start a new list of icons for 
the selected workbook.

To restore the QAT to its original set of three icons, choose the Reset button.

Adding Icons for VBA Macros to the QAT

When you are customizing the Quick Access Toolbar, the left dropdown offers a setting for Macros. 
This will display all of the macros available in open workbooks, plus macros available from installed 
add-ins. Each macro has an identical icon.

Choose a macro from the list and click the Add button to add it to the QAT.

•

•

•

•

Figure 4.20
Choose a macro from the left 
list and add it to the QAT.
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After adding the macro to the QAT, you can select the macro in the right listbox and choose Modify. 
The Modify Button dialog appears with 200 new icons. Try to fi nd an icon that might work with 
your macro. Also, you can type a new name for the button. This name will appear as a tooltip when 
you hover over the icon in the QAT.

Figure 4.21
The previous version of Excel 
offered 4096 custom icons. 
Being limited to only 200 is 
an incredible disappointment.

Adding Too Many Icons to the QAT

If you add too many icons to the QAT, only the fi rst row of icons is shown on the QAT. A More Con-
trols icon appears at the right end of the QAT. (Figure 4.22). Click the More Controls icon to see 
a second row of QAT icons. (Figure 4.23). If you have even more icons than will fi t on the second 
row, a scrollbar at the right edge of the second row of the QAT will allow you to scroll through the 
additional icons.

Figure 4.22
If you have more than one row 
of icons, use the More Controls 
icon to see the rest.
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Figure 4.23
Even the second row 
doesn’t show all of the icons 
that have been added.

Note: Writing a book can be deceiving. In the original outline for this book, I 
sort of dismissed the QAT and thought that this would be a one page chapter. 
Even though it is easy to customize the QAT, there are a lot of different options 
to help make the QAT useful for you.

Caution! The previous chapter talked about using keyboard shortcuts. While it might be 
possible to memorize some keyboard shortcuts, it will be hard to memorize the keyboard 
shortcuts associated with the QAT. The QAT icons are assigned shortcut keys on the 
fl y every time that you hit the Alt key. If you want to reliably memorize certain QAT 
icons, be sure to add them to the leftmost section of the QAT, before any icons that may 
occasionally be grayed out.

* * *



Chapter 5

Unlocking the Big 
Grid

Excel 2007 offers more rows and columns.

That is an understatement.

This table shows the magnitude of the increase, but I am not sure that numbers do it justice.

Excel 97-2003 Excel 2007 % Change
Rows 65,536 1,084,576 1500%

Columns 256 16,384 25500%

Cells 16.7 Million 17.2 Billion 102300%

In case you wondered how Microsoft comes up with numbers such as 16,384 and 1,084,576, these 
are powers of 2. There are 2^20 rows and 2^14 columns.

In the prior version of Excel, you could not have daily dates for one year stretching across the 
columns. In the new version, you can show weekdays for 46 years before you run into the last 
column (XFD).

This chart helps you to visualize how large the new grid is. The green area is the size of one 
worksheet in the new Excel. The tiny yellow box in the lower left corner is the size of one worksheet 
in the old Excel.

Figure 5.1
The yellow is the size of the old 
Excel grid. The green is the size 
of the new Excel grid.
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Caution! When you perform the above steps, Excel will erase the .xls version of the 
fi le and replace it with an Excel 2007 version of the fi le. If you prefer to keep both 
versions, use File – Save As to save an Excel 2007 version of the fi le.

After converting the fi le, you can see cell XFD1048576:

Figure 5.2
The new fi nal cell in the 
big grid.

Named Ranges That Can Be a Problem

It is possible to name a range in Excel. Useful names might be “Expenses” or “TaxRate”. A range 
name cannot duplicate an existing Excel cell name.

There are a lot of three letter words that used to be safe range names that would now be problems. 
For example, “Tax97” or “ROI2007” would have been valid names in Excel 2003, but are now cell 
addresses in Excel 2007.

What Happened to the Big Grid?

I was excited to see this new, larger grid in Excel 2007. The fi rst thing that I did was to open one of 
my old workbooks. After pressing End+Down arrow and End+Right arrow, I was disappointed to 
see that I was only at cell IV65536. Here, I am in Excel 2007, yet the grid only has the old limits! 

This problem happens because the when you open an Excel 2003 workbook in Excel 2007, it is 
opened in Compatibility Mode. When you are in compatibility mode, you cannot access any rows 
beyond 65,536.

To exit compatibility mode, follow these steps:

From the Offi ce icon menu, choose Convert.

Read the note that you are about to convert the fi le and click OK.

Read the note that the conversion was successful. In order to access more rows, you need to 
close and re-open the workbook. Click Yes to do this.

1.

2.

3.
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Figure 5.3
In Excel 2007, Tax97 is a 
cell address.

If you attempt to convert an existing fi le that uses a name such as Tax97, Excel will alert you and 
convert the range name to _Tax97. 

While all references in formulas will automatically update, you should check any VBA macros or 
OFFSET functions to see if they explicitly referenced the old range names.

Who Needs This Many Cells?

After using Excel 2007 for a year, I’ve never had an occasion to use 17 billion cells. However, I have 
run into datasets that fi lled A1:S675000. I’ve also run into CSV fi les from Quickbooks that had 
more than 500 columns.

So, while you may never need 17 billion cells, there are times when you will need more than 65K 
rows or 256 columns. Microsoft realizes that changing the grid size causes a change in the fi le 
format. The new grid size is designed to get you through the next several versions of Excel.

* * *




